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Today’s students are exposed to a barrage of media throughout the day. Because of this, it can be difficult to capture their attention in the classroom. You are faced with the challenge of integrating  rich media into the curriculum. Digital media is readily available, but can it enhance learning? How can you, with little spare time, integrate digital media in a way that improves learning in your classroom? 

There is also the very real issue of individual student needs. Students bring many different personalities and abilities to your classroom. How can you accommodate individual needs without compromising the quality of the material for the larger group? How can you get those shy students to come out of their shells? How can  you help parents review lessons with their children? How can the classroom be enriched with enhanced communication abilities? 

The Windows XP operating system can help you meet these challenges. It contains digital media tools that can support technology use in the classroom, extend its educational use in students’ homes, allow you to include rich media resources in your curriculum, and improve communication among students, between you and your students, and between you and parents. 
In this tutorial you will learn to:

· Use and organize digital media
· Enhance electronic and hard copies of digital images
· Distribute digital class materials, like videos, music, presentation, and electronic text
· Produce your own digital content for use in and out of the classroom
· Use media to speak to individual learning needs
Four Windows XP tools allow you to do all this. You will learn about all four in this workshop. They are:
My Pictures. Edit and organize photos, create an online photo album or post photos to a Web site, add photos to a CD, and even order prints online. 

Windows Media Player. Perform virtually any task with music, from simply listening to a CD or Internet radio station to creating your own CDs and customized playlists. 

Windows Movie Maker. Transfer files to your computer from a camcorder or digital video camera, or import external audio and video files into your work. Collect, view, and edit video clips, and share your work by sending files in e-mail or posting them to a Web site. 

Windows Messenger. Send instant messages to colleagues, issue text messages to cell phones, place calls directly from your computer, hold department meetings online, share files with students, and more. Use online notification status to set your online status to inform others that you are away, or see immediately who is available online. 

Suppose your class is currently studying volcanoes One of your students has recently returned from a trip where he collected a good deal of information on some of the Pacific Rim volcanoes. You charge a group of students to research and create a presentation about volcanoes, incorporating the material that he brought back. 
Students will create an online photo album to share with other students. Members of the group will collect and compile music to serve as background music to enhance the presentation. Students will use Windows Messenger to communicate with their group members, to hold meetings online to coordinate project details, and to collaborate on their work.
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Increase Efficiency by Using Digital Photos   

For the classroom, digital really makes sense, because it saves on resources and the images can easily be made available to the entire class and people outside the class. However, in order to use digital cameras in the classroom you need to know how to handle three tasks that have presented challenges in the adoption of digital photography: viewing and organizing photos, sharing photos, and printing photos. The following sections show how Windows  XP tools can help you with these tasks. 
Windows XP helps you and your students view, organize, and share digital photos. By using a digital camera or scanner and your computer you can view photos immediately, transfer, edit and organize them for a class project, create a slide show for a presentation, collect photos on a CD to distribute to parents, post them to the school's Web site, and more.

Viewing and organizing your photos

Organizing your photos is easier than ever. As discussed in Windows XP 101: Using Windows XP Professional in the Classroom, My Pictures is a feature of Windows XP that enables you to organize, view, and print your photos with ease. My Pictures includes useful icons and task descriptions that enable you to complete the tasks you want quickly and efficiently. Photos are automatically stored in the My Pictures folder, and you can view all photos from this location. 
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Alternate viewing options can be selected from the View menu in My Pictures. Some photo viewing options include:
Filmstrip. This default view shows four reduced-size photos on-screen at a time, with one image enlarged. You can click any image to enlarge it, and then rotate it 90 degrees clockwise or counterclockwise. Move between photos by using the Next Image and Previous Image buttons.
Thumbnail. This displays your photos as small thumbnail images. You can also view photo titles directly beneath the images.

Slide Show. This displays full-screen sized photos one at a time in succession. After this view is selected, the slide show runs automatically.

Details. This optioin lists your photos by name with details, such as size, type, and date modified.
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If you connect a digital camera to your computer, photos that are downloaded into My Pictures are named automatically according to the date they are transferred to your computer. You can create new folders according to the subject of the pictures, such as Volcano Research Project or you can rename existing folders. To rename a folder, right-click on the default folder name, and then click Rename. Type in the name you want to use for the folder. You can also name each photo in a way that works best for you, such as by subject or numerical order. 

Sharing your photos
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You can share photos with parents, colleagues, or others by creating an online photo album, posting photos to a Web site, or sending them with e-mail. The new compression feature of Windows XP enables you to compress your photos so that they are easier to send by e-mail. In addition to reducing file size, this feature also changes the dimensions of the image so that it fits better on a computer screen. Whether you send photos by e-mail or post them to a Web site, the process is straightforward.
Suppose students have developed a Web site devoted to their volcano project. They decide to post photos to that Web site as a preview of what will be discussed in their presentation. You can also post photos of class activities to make them available to parents. 
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To post photos to a Web site
1. On the Start menu, click My Pictures.

2. Browse to the folder that contains the pictures you want to post to the Web site. 

3. On the left-hand menu, under File and Folder Tasks, click Publish this folder to the Web.

4. The Web Publishing Wizard opens. Follow the instructions to select the pictures you want to publish to the Web, and to specify the location of your Web site. You will have to have authorship permissions to the Web site in order to accomplish this. 
Printing your photos
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Windows XP Professional provides the tools that enable you to print your own photos successfully and economically. By using My Pictures, you can print your own photos, order prints from the Internet, or set a photo as your desktop background. Greater control over the printing process means you only print those photos that you want; you can delete any photos that you don't want from your computer. The new layout tool helps you use the space available on your photographic paper in the most efficient way by setting the size and rotation of the prints. This saves you the cost of printing multiple copies of your pictures. Available layouts include full page, contact sheet, and various standard photo sizes such as 8 x 10, 5 x 7, or wallet size.
Note: To achieve the best printing results, be sure to use a high-quality glossy paper that is designed for printing photos, and to set your printer to a high resolution.

After the students have organized their photos in the appropriate folder in My Pictures, perhaps you’d like to spruce up the classroom walls with them. A constant visual barrage of the subject matter may just help the students cultivate an affinity for the topic. Let’s say that your students determine that a 5 x 7 photo size will work best for the display that they want to create for the bulletin board. 
Note: To continue with this example you must have a printer set up for the computer that you are using to print your photos. Even if you do not wish to complete the process and actually print anything, a print driver must be present to allow a potential printed page to be formatted.

To print your photos by using the Photo Printing Wizard 

5. On the Start menu, click My Pictures.

6. Click to select the pictures that you want to print. 

7. Under Picture Tasks, click Print the selected pictures.

8. The Photo Printing Wizard appears, displaying images from the folder that you selected. Click Next to continue.
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9. Click on two photos that you want to print. Selected photos are identified by a check mark. If you want to print all photos, click Select All. If at any time you want to clear your selections, click Clear All. 

10. Click Next to continue.

11. Select the printer you want to use, and then click Next to continue. To add a new printer, click Install Printer, and follow the on-screen instructions.

12. Click Printing Preferences. On the Layout tab, select the Orientation, Page Order, and Pages Per Sheet choices that you want to use.
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13. On the Paper/Quality tab, select the paper source that you want. Click the Advanced button to change properties such as Print Quality and Scaling. Click OK, and then click OK again.

14. Click Next to proceed to the following screen. In the Available layouts pane, select 5 x 7 in. cutout prints: cropped and rotated to fit. The Print preview pane displays how your photos are sized on the page. 

15. Click Next to continue. A message appears informing you that your photos have printed successfully. Click Finish to close the Photo Printing Wizard.

Some students want to order prints of a few of the volcano photos to frame. They can do so by using the Online Print Ordering Wizard to order prints over the Internet from professional photo processing sites.

To order prints of your photos online

16. On the Start menu, click My Pictures. 

17. Click to select the photos that you want to print. To select more than one, hold down the CTRL button as you click each one.

18. Under Picture Tasks, click Order prints online. 

19. Follow the on-screen instructions in the Online Print Ordering Wizard to complete your order.
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You can select additional photos to print or clear photos that you decide not to print. You can then choose a printing company of your choice, and follow the instructions to place an order. Each company has different procedures and requirements. 

Using Music and Audio to Enhance Class Projects 
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With Windows XP, you and your students can vitalize and add depth to class projects by incorporating music into them. You can also accommodate individual needs by communicating the information in a way that is aligned to students’ individual learning styles. Exercises can be brought to life through the proper use of audio. Just think of the possible applications in language learning , English as a Second Language instruction, and Learning Disabled classes. 
The following sections discuss the various ways that Windows XP helps you to support teaching and learning in your classroom by adding music and audio to your lessons.
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About Windows Media Player

· Create a CD
· Customize Your Music

With Windows XP, incorporating music into your curriculum is easier than ever before. You can play audio and video files, listen to CDs, organize your music, and access Internet radio stations worldwide—all from Windows Media Player. Windows Media Player works with the My Music folder to provide a central storage location for all your music files. The My Music folder contains links to music-related tasks that can help you learn about your music, whether it’s genre music for a class project, recorded music made by students, or music for studying an artist. Also, don’t forget that curriculum content can be generated for digital learning systems like Microsoft Class Server that allows integration of audio material into the main learning and exercise documents.
About Windows Media Player

So, what is Windows Media Player? It is a unique application that you and your students can use to: 

· Listen to, copy, and even create CDs

· Listen to Internet radio stations

· Catalog your music by album, artist, or genre

· Locate audio files on the Internet 

· Watch DVDs and video on your computer 

Because music is stored in Windows Media Audio 9 format, Windows Media Player can store twice the CD-quality music as MP3, using the same amount of disk space. As an easy way to preserve space on your computer, you can save your music to a CD and add it to your collection. Students can work collaboratively to compile CDs to accompany class projects, and even distribute the CDs at fundraising events. 

You can even personalize the look of Windows Media Player by using new customizable skins. A skin is a file that changes the appearance and functionality of Windows Media Player, giving you greater creative control of your desktop.
Customizing Your Music

Windows XP gives you an extensive set of customization options for your music. You can rearrange the order in which CD tracks are played, and organize your music in a way that works best for you. The Media Library provides categories for album, artist, genre, and even includes an All Audio folder that contains all of your audio files, including those you collect from the Internet.

Creating a playlist is a useful way to customize music for a class project, but you might also want to compile a playlist for personal listening. A playlist is a customized list of digital audio or video files that you can store. You can also use a playlist to compile your own CD or to copy files to a portable device. For example, students might compile a CD for their volcano project that includes background music, video clips of erupting volcanos, and audio interviews with people that have witnessed eruptions.

Note: An item must be available in the Media Library before you can add it to your playlist. To add items to the Media Library, click on the File menu and select the Add to Media Library option. The first time the Media Player is started it will prompt you to scan your system for available media. During the initial scan it will also prompt you to allow it to fill in missing title information for existing media in the library. (It can fill in the album for a particular song, for instance.)
In our example, students will add music and other audio or video files to the Media Library, and then create a playlist for their presentation. 
To listen to music

20. Click on Start, All Programs, and then Windows Media Player. You are ready to add files to your Media Library.

21. Click File, Add to Media Library, and then Add Folder. Click OK to use the default folder called My Music, or click Make New Folder to create a folder for a specific project. After you have created a folder and clicked OK, Windows Media Player will search your computer for audio and video files to add to the folder. 
22. To add files to your music folder click File, Add to Media Library, and then Add file or playlist. A window opens from which you can search your  computer to locate the file. Navigate to the file you want to add, select it, and click Open.

Virtually any type of audio file may be organized this way, including traditional audio CDs, MP3 files, and .wav files. 
To create a playlist

23. On the Start menu, click All Programs and then Windows Media Player.

24. Click Media Library, Playlists and then New playlist.
25. In Enter the new playlist name, type a name for your new playlist, such as Volcanoes Soundtrack, and then click OK. The new playlist appears in the My Playlists folder in the Media Library. 
26. Select any tracks in the left pane and they will automatically be added to the playlist which is displayed in the right pane. The up and down arrows change the order of the playlist and the x at the bottom of the pane will remove a selected track from the playlist.
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27. After you have created a playlist, you can add more files in the Media Library to the new playlist. To do so, select the playlist that you wish to add the tracks to. Click Playlists on the toolbar and click Edit Playlist. Click on the audio track(s) you want to add in the left hand pane. Each track you click on in the left hand pane will be added to the current list. Click OK when you are finished.

Creating a CD

Have you ever painstakingly created a compilation tape for a music class, or pieced together music for a school event? Audio is easier to use, more accessible, and more durable on a CD than on a cassette tape. The time consuming process of forwarding to the correct point on a tape, and the physical deterioration of a cassette from heat and use can be completely eliminated by using CDs instead of tapes for your music. 
Creating your own CDs is simple when you use Windows XP. Students can create a CD as part of an assignment, or you can create CDs as supplemental class material. As mentioned in the previous section, you can use Windows Media Player to burn your own CDs from the files that you have stored in the Media Library.

In our example, students decide to create a CD to distribute to parents and other visitors at their evening presentation. Collecting music from various CDs brought in by other students, and using some tracks from their current playlist, they work together to determine which songs best convey the culture of Brazil and excitement of South America’s volcanoes. 
Note: To play audio files, you must have a sound card and speakers (or headphones) hooked up to your computer.
To burn a CD

28. On the Start menu, click All Programs, then Windows Media Player.

29. On the left-hand menu in Windows Media Player, click Copy to CD or Device.

-OR- 

30. On the File menu, point to Copy, and then click Copy to Audio CD. 

31. In the Items to Copy pane, select the playlist or category of tracks that you want to copy from Media Library. The number of items that you select and the total time appears at the bottom of the Music to Copy pane. 

32. Clear any text boxes for tracks that you do not want to copy. The playlist may be modified from the Edit Playlist button.

33. Insert a blank CD-R or CD-RW into the CD recording device or drive. 

34. In the Items on Device pane, click the recordable CD-ROM drive. Before tracks are copied to your CD, they are checked and converted to a file type for your CD. This process can take several minutes. 

After the CD copying process is complete, you cannot copy additional tracks to the CD. If you are using a CD-RW, you can use another program to erase the CD before using Media Player to copy tracks to the CD again. 

CAUTION: If you perform any other actions while creating a CD, the player might stop functioning. 

Using Video to Build Dynamic Presentations   

Another way that students and teachers can create classroom presentations that encourage all students to become more interactive and involved is by using video. You will learn about effectively creating and using video in the following sections:
· About Windows Movie Maker

· Editing Your Movies 

· Sharing Your Movies

· Playing Movies and DVDs

Playing, editing, and recording video on your computer is a fun and easy way to encourage collaborative learning. A video can be produced for a lesson and placed on the class Web site (we will cover this in the topic Sharing Your Movies). Now parents can review the content with their children. Students can revisit information that they missed in class. Links to additional material can facilitate learning for your advanced learners and content may be stopped and repeated for students who wish to review the material. Through this set of simple tools you can accommodate the learning needs of all your students. 
With Windows XP, you and your students can copy your own video segments to the computer, and then edit them with audio and video supplements. Whether students are conducting field research or interviewing one another, the interactive process of video enhances collaborative learning and encourages creativity. Student project submissions can be much more active and engaging. Who knows, those shy students who have trouble speaking in front of the class may let the movie do their speaking for them. 
Movie Maker 2.0 is the latest version of Microsoft’s drag-and-drop movie editing software. You can download it free of charge from the Microsoft web site at http://www.microsoft.com/windowsxp/moviemaker/downloads/moviemaker2.asp.

Installing the latest version of Movie Maker onto your computer will replace any previous version and automatically convert any version 1.0 video collections you have to the new version. 
About Windows Movie Maker 

With Windows Movie Maker 2.0, you can create your own movies, or transfer recorded audio and video from a digital camera or camcorder to your computer. You can then create, edit, and preview your own movie all from your computer.
After you've edited your movie, you can burn it to a CD, share it with students and colleagues by using e-mail, or post it to a Web site. With the new Windows Media 9 compression technologies, files are smaller in size and can be viewed easily online or sent by e-mail in less time.
Features of Windows Movie Maker allow you to: 

Capture Files -  Add audio, still pictures and video to your project through wizard- based functionality. Import existing video and audio and capture new clips to use in your movie.
Edit your Movie -  Insert audio or video clips, trim them to delete unwanted segments, create transitions, and more.

Manage your Movies -  Save your video and audio clips in a central storage location  called My Collections. Name and rename clips in a way that works best for you. Think of this as the palate of colors artists collect before painting, which enables them to have all the resources for a project at their fingertips.
Finish and Share your Movies -  Choose from several storage locations and delivery methods for your completed movie. You may select to save your movie to the computer, a CD, an e-mail message, the Internet, or a miniDV camera.

Learn More -  Movie Maker provides you with step-by-step assistance in creating movies. You will fin help on the four phases of development: capturing video, editing clips, adding titles, effects, and transitions, and saving and sharing movies.

Creating Movies with Windows Movie Maker

35. Download and install onto your computer the latest version of Movie Maker from the Microsoft Windows Movie Maker download Web page. 

36. On the Start menu, point to All Programs, and then click Windows Movie Maker.
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37. In Movie Tasks click Import video. The Import File window will open.
38. Navigate to the folder on your computer which holds your  video files,  and click on it.

39. Select the video clip you want to use click Import. Repeat this process as many times as necessary to bring in all video clips needed for your project.

Note: This process will take a few seconds to a few minutes, as Movie Maker examines the inbound video and generates clips from it. Clips are created from natural segments in the video. These segments are created each time you start and stop recording.

40. If you want to include still shots in your movie, go to Movie Tasks and click Import pictures.

41. Navigate to the folder on your computer that holds pictures you want to use, and click on it.

42. Select the picture files from the folder and click Import to import them into Movie Maker.
43. Now you’re ready to get audio or music files. In Movie Tasks click Import audio or music.

44. Navigate to the folder on your computer which holds your audio or music files. Click on it and then click on Audio to open the sub folder.

45. Select the audio or music files in the folder that you want to use, and click Import to import them into Movie Maker.
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You will see all of the imported files listed in the collections pane. You may switch to different collections using the collections drop down menu above the collections pane.
It’s time for you to actually create the movie now that all the media has been collected.

46. If you have already created a PowerPoint slide show to use in your movie, Movie Maker will use the slide shots to help you get organized. Incorporate the PowerPoint slide shots into the movie by dragging them in order onto the storyboard (the series of blocks in a strip at the bottom of the screen). 
47. Next try placing a video clip in with the still slides. Select a video clip from the collection and drag it onto the storyboard between two of your slides. Video clips appear as motion picture film strips.
48. Now add some background audio to enhance your movie. In the collection above the storyboard, drag whichever audio file you would like as your background audio onto the storyboard. Make sure the little vertical line, showing the insertion point, appears before slide one. This will make the audio track start at the beginning of the movie.
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49. A warning message will display warning you that audio clips can only be added in Timeline View and you have been automatically switched to that view. Just click OK and the audio will be added.

Note: If you want to change the position of an audio clip in your movie, you can simply drag the clip to a different place. This drag and drop editing is available for all aspects of Windows Movie Maker.
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50. Click on the video clip and then click the play button in the playback pane on the right side of the screen. Watch a few seconds of the video and press the pause button. Next you will learn how to shorten a video that is too long by splitting it and removing unnecessary parts.

51. Click the Split button [image: image10.jpg]


 to split a long video clip into two sections. After splitting the video you will see two distinct clips.
Note: You may obtain stills from your video using the Take Picture button immediately to the left of the Split button.

52. Click on the second clip and press your Delete key to remove it. Don’t worry if you deleted the wrong clip; the Undo button will restore the clips as they were, allowing you to try again.

You may also notice that you can record directly from a digital camcorder if your computer and video camera support each other. Just use a cable to connect the computer and camera and you are ready to go!

Next you will learn about some editing tricks using Movie Maker 2.0.

53. Click on the audio clip you inserted and move your cursor to the right end of the audio clip. Your cursor will change to a red horizontal line with arrows on either end. Click and drag to shorten the music to match the end of the last slide. In this way when the video ends so does the audio.

54. Click on View video effects and drag the desired effect on any clip in the timeline to add that effect. Repeat this for each clip.

55. Click on View video transitions and drag the desired transition between the clips on which you wish to apply the transition.

56. Click on Make titles or credits to create titles and end credits for your movie. Just click on the desired option and fill out the text for the title. Then you can set the options for color, text font and animation.
57. At any point during the process you can view the results of your work by selecting Play Timeline from the Play menu You can also click on the Play button in the video pane to view your presentation.

You can also split a video clip into two clips to insert something in between, or combine clips that are contiguous. This is useful if you have several short clips that you want to view as one clip within the workspace. You can split video content into two clips from your current project, or from the Collections location. You can also edit the properties of a clip, such as title or author. This feature is especially helpful when you are working with several clips. 

The creative options are endless with Windows Movie Maker. By using the View menu, you can switch from Storyboard to Timeline view, and you can also zoom in or zoom out to get a better look at your material. You can add clips by using the Clip menu, and you can set trim points to eliminate content that you do not want. After you have added the clips to trim to your collection, you can trim the start or end points of those clips. Note that trimming the clips does not alter the original, or source material, and you have the option to clear your selected trim points at any time. You can also add transitions, effects, titles and credits to your movie. You can explore these options by using the AutoMovie feature.
Creating Movies with AutoMovie
Now that we’ve explored creating a movie manually, let’s discover what AutoMovie can do. You want to start out with a clean project because AutoMovie is going to do everything for you. All you have to do is assemble the video, audio and still clips in a collection and Windows Movie Maker will make a really great movie complete with effects, transitions, titles and credits.

58. Select Make an AutoMovie from the Edit Movie section of the Movie Tasks pane.

59. Select the desired type of movie (Flip and Slide for this example).

60. Click Enter a title for the movie and type your title in the box provided.

61. Click Select audio or background music and use the browse button to select your underlying music.
62. Click Done edit movie to begin the movie creation process.

Enjoy your newly created and fully functional movie! There has never been an easier way to create video content. If something isn’t exactly as you’d like it, just use the editing tools we have discussed to modify any of the aspect of the movie.
Sharing Your Movies

Sharing movies is an excellent way to collaborate with other students, and to present the findings of a research team. Students can send a movie by e-mail for peer editing, post a movie to a Web site, or save a movie to a CD to distribute to parents. You can save your movie file to a shared folder on your computer so that others on the same network can view it. Students can even send movie files by using MSN Messenger.
There are many options for posting movies to Web sites. Students can post movies to the school's Web site, the class home page or a Web site dedicated to a specific project. 

To post a movie to a Web site

63. On the Start menu, click All Programs and then Windows Movie Maker.

64. Open the movie file that you want to post to a Web site.

65. On the File menu, point to Save Movie File, and then click The Web.

66. Type a name for you movie and click Next.

67. Choose the desired connection speed and click Next.

68. Select the video hosting provider or save a copy of the movie on your computer and click Finish.
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To distribute your movie on a CD 

69. Insert a blank writable CD into the CD-ROM drive of your computer.

Note: Writable CDs include recordable compact discs (CD-Rs) and rewritable compact discs (CD-RWs). Be sure you are using writable CDs to store your photos, music, and video.

70. Click Save to CD in the Finish Movie section of the Movie Tasks pane.
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71. Type in the name for you movie and click Next. 
72. You can modify the settings for movie quality (although we recommend using the default settings). Click Next. 

73. The movie will be written to your CD. Click Finish when the process is complete.

Playing Movies and DVDs

The My Videos feature of Windows XP lets you choose to view your videos as Thumbnails (the default), Icons, Tiles, and more. You can also add your video clips to a playlist from the File menu. When you choose to watch a video from My Videos, the Windows Media Player launches automatically and your video starts to play.

Watching DVDs with students for class projects is easy when you use Windows Media Player—simply play the DVD on your computer and broadcast the video to a screen in the front of the room. Playing a DVD is much like playing a CD; you insert the CD into the CD-ROM drive of your computer, and then start Windows Media Player. With a DVD-ROM drive on your computer, you can play full-length feature film DVDs in class without having to go through the trouble of locating the school’s VCR and using a VHS tape.

Windows Media Player includes full-screen video controls for Windows Media Video and DVDs. By using Windows Media Player 9 full-screen playback, you can achieve excellent viewing quality for video clips over a high-speed Internet connection.

Collaborating with Others by Using Real-time Communication

Teachers can save valuable time by using the real-time communication features of Windows XP Professional found in Windows Messenger.
As discussed in Windows 101: Using Windows XP Professional, Windows Messenger is a comprehensive communication tool that offers real-time audio and video conferencing, application sharing, and simplified online collaboration. Voice and video features are integrated to provide superior real-time communication, regardless of location. You can increase everyday efficiency by using this communication tool to hold spontaneous online discussions with colleagues, conduct department meetings, exchange files, and share applications for review and collaboration.
About Windows Messenger 

Windows Messenger is an instant messaging program and much more. Students can use Windows Messenger for quick communication any time—they can hold online group discussions, collaborate on homework assignments, send another student’s  cell phone a text message, or share files. With the audio and video features of Windows Messenger, students can have meetings with individuals from other schools, or research experts around the globe.

By using the contact list status and notification support tools, you can see who is online immediately after you sign in. This prevents you from wasting time unsucessfully trying to reach people by phone or e-mail. For example, suppose you need to contact a colleague for a brief discussion before a department meeting. You sign in to Windows Messenger and notice that she is online. You can then send an instant message to her, and start an online chat session immediately. You can also set your own online status to Busy, Away, Be Right Back, Out to Lunch, and more.  

Suppose a couple of students need to speak to students in another country that helped them with their volcano project. Although a telephone call is scheduled for the following week, local students getting together for a study session see that some of the overseas students are online. They can initiate a spontaneous discussion by using Windows Messenger.

To hold a collaboration session after school hours

74. On the Start menu, point to All Programs, and then click Windows Messenger.
75. In the Windows Messenger window, click the message to sign in.

76. Type your e-mail address and password in the appropriate boxes, and then click OK.
77. Windows Messenger opens. The names of the contacts on your contact list appear at the top of the window, under Online or Not Online. 

78. To send a message to an online contact, go to the Tools menu, select Send an Instant Message, and then click the name of the recipient. 

79. A conversation window opens. Type your message in the bottom pane of the window and then press ENTER to send it to the recipient. Your message and their reply will appear in the top pane of the conversation window.

80. To invite more people to the conversation, click Invite on the Tools menu, and then select the contact to invite. Repeat this process to invite everyone to the conversation.
Additional Resources

You can find additional help and resources in the Windows XP Professional Support Center. The Support Center is a central location for Help topics, tutorials, troubleshooting, and other support services. 
Windows XP 101: Using Windows XP Professional in the Classroom 
This tutorial discusses the help services of Windows XP Professional in detail, including Remote Assistance and Microsoft Online Assisted Support. Both are available through the Help and Support Center. Remote Assistance lets you send an online invitation to anybody, anywhere, and enables them to share control of your computer. Microsoft Online Assisted Support lets you obtain professional help over the Internet.

Windows XP Professional in the Learning Environment 

This Web site provides information on how Microsoft Windows XP helps increase instructional productivity and enhances collaboration. Discover resources and tools to support your teaching and learning.

Windows Media Player Home Page
Learn everything you want to know about using Windows Media. This site also contains great files that you can download to use with Windows Media Player and Windows Movie Maker.
Information in this document, including URL and other Internet Web site references, is subject to change without notice. Companies, names, and data used in examples herein are fictitious unless otherwise noted.
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�By using digital photos, you can: 





Organize photos with ease by saving them to your computer. To save hard disk space, you can delete photos that you do not want.





Save money by printing only the photos that you want, in the sizes you need. By using photo-quality paper, you can achieve professional results at a fraction of the cost.





Share photos easily by using e-mail or creating an online photo album.








�To simplify sending photos in e-mail, you can compress the size of your photos. This makes it easier to send and view photos from any e-mail program. 











�Collaborate with students around the world by posting photos to a Web site—share photos with area experts for feedback, or collect photos to use for a class project.








�Contact sheet prints enable you to view the quality of all your photos, and then select only those photos that you want to print in larger sizes. You can view up to 35 prints per page.








�Become familiar with the features of Windows Media Player :





Now Playing. Watch DVDs, videos, or play music with graphics.





Media Guide. A live Web page with links to the latest movies, music, and radio stations. 





Copy from CD. Select CD tracks to store on your computer. 





Media Library. Store and organize digital media files.





Radio Tuner. Locate Internet radio stations around the world.





Copy to CD or Device. Transfer digital media files to a CD or portable device.





Skin Chooser. Personalize the appearance of Windows Media Player by changing the look, or skin.





Premium Services. Paid streaming content providers that offer subscriptions to specialized content.





�





�Save time and money by creating your own CDs—build CDs for class curriculum, have students create CDs for projects, or compile your own CDs for personal listening.





�Students can conduct interviews with individuals and archive that information easily onto a CD.





�Some terms to know:





Clips. Audio, video, or still images stored in Windows Movie Maker. 





Source Material. The original audio and video content that was recorded into Windows Movie Maker.





Source File. The original media file that was imported to Windows Movie Maker.





Content. Audio and video media, text, and other images that are part of a multimedia presentation.





Transitions. The method of moving smoothly from one video clip or photo to another.





Storyboard. A view of the workspace that displays the sequence of your clips.





Trimming. Removing parts of a clip that you don’t want to include without deleting it from the source material.�





�Students will enjoy the creative freedom of editing their video footage.





�Students can increase collaboration and cultural learning by sharing movies, such as research footage of a local celebration, or interviews of field experts.





�Make the most of your time by using Windows Messenger to communicate with colleagues and students in real-time, regardless of location—discuss homework assignments, hold online department meetings, and much more.





�By using the Send an Invitation feature on the Tools menu, you can send an invitation for Application Sharing, Remote Assistance, or Using the Whiteboard.





�Enjoy greater creative control and enhance presentations by using Windows XP to create customized CDs that include photos, music, and video. 








You will learn to:�


Simplify photo storage and organization by storing photos on your computer


Save money by printing your own high-quality photos


Create customized, economical CDs for class projects by using photos, music, and video 


Create and edit your own documentaries, movies, and more


Collaborate with colleagues from any location by using advanced voice and video communications.
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